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Preface

Welcome to Sun Java™ Communications Suite. The Sun Java Communications Suite delivers
industry-leading email, calendaring and real-time collaboration functionality for service providers
and large organizations worldwide. The suite provides an extensible, standards-based development
platform, offering improved performance, reliability and scalability at a lower total cost of
ownership. This guide provides demos that enable you to use, learn about, and evaluate the Sun Java
Communications Suite software.

Who Should Use This Book

This guide is intended for any evaluator, system administrator, or installation technician who wants
to evaluate the services delivered by Sun Java Communications Suite.

Before You Read This Book

To use this guide, you need an evaluation system that has Communications Suite software installed.
See the document titled Deployment Example: Sun Java System Communications Services 2005Q4 on
a Single Host for instructions on how to build a complete test system before using this guide.

What This Book Covers

This document complements the single host installation document and is meant to assist you in
using and evaluating the platform once it has been installed. This document provides demos
organized by Communications Suite component product area. Within these areas, several features
are presented. A complete list of component areas and features is provided below.

= Portal Server as content aggregator:

®  The Instant Messaging channel
®  The Communications channels
= Access Manager and single sign-on

= Communications Express overview
= Messaging demo:

= HTML editor
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Spelling check
Advanced search
Advanced folder topics
Options and filters

= Calendaring demo:

User interface layout

Calendar views (month, week, day, and so forth)
Viewing other calendars

Calendar subscription and creation/ownership/permissions/time zones
Calendar groups (personal enterprise/service provider)
Event creation/group scheduling

Event/Invitations view

Searching (calendars and events within calendars)
New task creation

Import/export

Options/time zones

= Address Book demo:

= Integration between Address Book and Mail/Calendar
®  Address Book creation
®  Quick Address Book creation

= Connector for Microsoft Outlook interoperability demo:

Calendar drag and drop

Mail compose and view

Address Book creation

Return to Communications Express

= Instant Messaging demo:

Contacts and contact groups

Chat with online buddy
Multimedia chat

Multiple simultaneous chat sessions
Invite others to chat

Alerts and polls

Conference room management
Moderating a conference room
Access and privacy filters

API filters

Access Manager provisioning and filtering
Archiving Instant Messaging

HTTP proxy

= Delegated Administration demo:

= Creating domains
®  Creating users

Sun Java Communications Suite 2005Q4 Evaluation Guide - May 2006
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Related Books

The URL for all documentation about Java Enterprise System and its components, including Sun
Java Communications Suite, is:

http://docs.sun.com/prod/entsys.05q94

Typographic Conventions

The following table describes the typographic changes that are used in this book.

TABLE P-1 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and Edit your . login file.

directories, and onscreen computer output
P P Use 1s -a to list all files.

machine name% you have mail.

AaBbCc123 What you type, contrasted with onscreen ~ machine_name% su
computer output
Password:
AaBbCcl123 A placeholder to be replaced with a real The command to remove a file is rm filename.

name or value

AaBbCcl123 Book titles, new terms, and terms to be Read Chapter 6 in the User’s Guide.
hasized (note that hasized
cmpRasize (note 2 some emphastze A cache is a copy that is stored locally.

items appear bold online)

Do not save the file.

Shell Prompts in Command Examples

The following table shows default system prompts and superuser prompts.

TABLE P-2 Shell Prompts

Shell Prompt

C shell on UNIX and Linux systems machine_names
C shell superuser on UNIX and Linux systems machine_name#
Bourne shell and Korn shell on UNIX and Linux systems $

Bourne shell and Korn shell superuser on UNIX and Linux systems #
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TABLE P-2 Shell Prompts (Continued)

Shell Prompt

Microsoft Windows command line C:\

Symbol Conventions

The following table explains symbols that might be used in this book.

TABLE P-3 Symbol Conventions

Symbol Description Example Meaning

[1 Contains optional 1s [-1] The -1 option is not required.
arguments and command
options.

{3} Contains a set of choices for  -d {y|n} The -d option requires that you use
arequired command option. either the y argument or the n

argument.

${} Indicates a variable ${com.sun.javaRoot} References the value of the
reference. com. sun. javaRoot variable.

- Joins simultaneous multiple = Control-A Press the Control key while you press
keystrokes. the A key.

+ Joins consecutive multiple Ctrl+A+N Press the Control key, release it, and
keystrokes. then press the subsequent keys.

- Indicates menu item File — New — Templates From the File menu, choose New.
selection in a graphical user From the New submenu, choose
interface. Templates.

Accessing Sun Resources Online

The docs.sun.com™ web site enables you to access Sun technical documentation online. You can
browse the docs.sun.com archive or search for a specific book title or subject. Books are available as
online files in PDF and HTML formats. Both formats are readable by assistive technologies for users
with disabilities.

To access the following Sun resources, go to http: //www.sun. com:

Downloads of Sun products

Services and solutions

Support (including patches and updates)
Training

Research

10 Sun Java Communications Suite 2005Q4 Evaluation Guide - May 2006
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®=  Communities (for example, Sun Developer Network)

Third-Party Web Site References

Third-party URLs are referenced in this document and provide additional, related information.

Note - Sun is not responsible for the availability of third-party web sites mentioned in this document.
Sun does not endorse and is not responsible or liable for any content, advertising, products, or other
materials that are available on or through such sites or resources. Sun will not be responsible or liable
for any actual or alleged damage or loss caused or alleged to be caused by or in connection with use of
or reliance on any such content, goods, or services that are available on or through such sites or
resources.

Sun Welcomes Your Comments

Sun is interested in improving its documentation and welcomes your comments and suggestions. To
share your comments, go to http://docs.sun. comand click Send Comments. In the online form,
provide the full document title and part number. The part number is a 7-digit or 9-digit number that
can be found on the book’s title page or in the document’s URL. For example, the part number of this
book is 819-6321-11.

1
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CHAPTER 1

Sun Java Communications Suite Highlights

This chapter describes the key features and benefits of Sun Java Communications Suite.

Sun Java Communications Suite is a secure, cost-effective communications and collaboration
offering. Communications Suite addresses customer concerns about the costs, capabilities, and
security of a traditional communications infrastructure by offering a secure, scalable, lower total cost
of ownership alternative to other communications and collaboration solutions.

Communications Suite provides the email, calendar, and instant messaging solutions necessary to
meet both enterprise and service provider communications and collaboration needs. All
organizations need communications, and many are required to provide these services across large,
diverse, and geographically distributed communities of users. Traditional communications solutions
are costly, and not sufficient to meet today’s requirements for scalability and security.
Communications Suite enables organizations to deploy solutions at a total cost of ownership they
can afford.

In addition, Communications Suite provides differentiated services and full-featured collaboration
functionality that are required by a diverse audience. Finally, a Communications Suite deployment
meets your increased security needs when extending communications outside of a corporate firewall
and to mobile users through multiple devices.

The Communications Suite core solution consists of the following components:

Sun Java System Messaging Server
= Sun Java System Calendar Server
®  Sun Java System Instant Messaging

Additional features that enhance the Communications Services solution include:

®  Sun Java System Communications Express
®  Sun Java System Communications Sync
= Sun Java System Connector for Microsoft Outlook

This chapter contains the following section:

= “Messaging Server Features” on page 14



Messaging Server Features

“Calendar Server Features” on page 14

“Instant Messaging Features” on page 14
“Communications Express Features” on page 15
“Communications Sync Features” on page 15
“Connector for Outlook Features” on page 15

Messaging Server Features

Sun Java System Messaging Server is a high-performance, highly secure messaging platform. Scaling
from thousands to millions of users, Messaging Server is suitable for businesses interested in
consolidating email servers and reducing total cost of ownership of the communications
infrastructure. Messaging Server provides extensive security features that help ensure the integrity of
communications through user authentication, session encryption, and the appropriate content
filtering to help prevent spam and viruses.

With Messaging Server, organizations can provide secure, reliable messaging services for entire
communities of employees, partners, and customers.

For more information about Messaging Server features, see the following documentation:
http://docs.sun.com/app/docs/coll/1312.1

Calendar Server Features

Sun Java System Calendar Server facilitates team collaboration by enabling users to manage and
coordinate appointments, events, tasks, and resources. With its intuitive, web-based interface,
Calendar Server enables end users to access their personal, public, or group calendars anytime and
anywhere, from a web browser. Deployments use Calendar Server, along with the Messaging Server
and Instant Messaging, to offer users a comprehensive communications and collaborative
environment.

For more information about Calendar Server features, see the following documentation:
http://docs.sun.com/app/docs/coll/1313.1

Instant Messaging Features

Sun Java System Instant Messaging enables secure, real-time communication and collaboration.
Instant Messaging combines presence awareness with instant messaging capabilities such as chat,
conferences, alerts, news, polls, and file transfers to create a collaborative environment. These
features enable one-to-one as well as group collaboration through either short-lived
communications or persistent venues such as conference rooms or news channels. Instant
Messaging, along with Calendar Server and Messaging Server, offers users a comprehensive
communications and collaboration environment.

14 Sun Java Communications Suite 2005Q4 Evaluation Guide - May 2006
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Connector for Outlook Features

Instant Messaging ensures the integrity of communications through its multiple authentication
mechanisms and secure SSL connections. Integration with Sun Java System Portal Server and Sun
Java System Access Manager brings additional security features, services-based provisioning access
policy, user management, and secure remote access. Furthermore, Instant Messaging supports the
Extensible Messaging and Presence Protocol (XMPP). XMPP enables you to use a number of
third-party clients, which aggregate contacts from the public networks. In one client, you can have
contacts from AIM, Yahoo, MSN, Sun, and other XMPP-based servers.

For more information about Instant Messaging features, see the following documentation:
http://docs.sun.com/app/docs/coll/1309.1

Communications Express Features

Sun Java System Communications Express provides an integrated web-based communications and

collaboration client. Communications Express is a common part of Messaging Server and Calendar
Server, providing end users with a web interface to their calendar information and mail, as well as an
address book.

For more information about Communications Express features, see the following documentation:
http://docs.sun.com/app/docs/coll/1312.1

Communications Sync Features

Communications Sync is a software product that runs on the Windows platform and enables users to
synchronize Calendar Server events and tasks with mobile devices and personal information
managers (PIMs) such as Microsoft Outlook.

See the Communications Sync documentation for more information:
http://docs.sun.com/app/docs/coll/1313.1

Note - Communications Sync is not used in this evaluation.

Connector for Outlook Features

Sun Java System Connector for Microsoft Outlook enables Outlook to be used as a desktop client
with Messaging Server and Calendar Server.

Connector for Microsoft Outlook is an Outlook plug-in that you install on end-users desktops.
Connector for Microsoft Outlook queries Messaging Server for folder hierarchies and email
messages. Connector for Microsoft Outlook then converts the information into Messaging API
(MAPI) properties that Outlook can display. Similarly, Connector for Microsoft Outlook queries
Calendar Server for events and tasks, which are then converted into MAPI properties. Connector for

Chapter1 « SunJava Communications Suite Highlights 15
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Connector for Outlook Features

Microsoft Outlook uses Web Address Book Protocol (WABP) to query Address Book Server for
contacts, which are then converted into MAPI properties. With this model, Connector for Microsoft
Outlook builds an end-user Outlook view from three separate information sources: mail from
Messaging Server, calendar information from Calendar Server, and contacts from Address Book
Server.

For more information about Connector for Microsoft Outlook features, see the following
documentation: http://docs.sun.com/app/docs/coll/1312.1

Sun Java Communications Suite 2005Q4 Evaluation Guide - May 2006
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CHAPTER 2

Preparing to use the Communications Suite
Evaluation

This chapter describes what you need to do to prepare to run the evaluation, including meeting the
requirements for the evaluation system and creating user accounts and sample data.

This chapter contains the following sections:

® “Using the Single Host Deployment Example” on page 17

= “Client System Interoperability Requirements for this Evaluation” on page 18
m “Creating User Accounts for This Evaluation” on page 20

m “Creating Sample Data for This Evaluation” on page 22

Using the Single Host Deployment Example

This evaluation assumes that you have installed all of the Communications Suite software on a single
host as outlined in the document Deployment Example: Sun Java System Communications
Services 2005Q4 on a Single Host.

Follow the instructions in the deployment example before continuing with this document.

The single host deployment example was installed using the following data. If appropriate, substitute
the host name that you used in place of wireless.map.beta.com.

TABLE 2-1 Single Host Deployment Example Data

Item

Value Notes

Host name

wireless.map.beta.com

Portal Server desktop URL http://wireless.map.beta.com/portal/dt

Communications Express http://wireless.map.beta.com/uwc

URL




Client System Interoperability Requirements for this Evaluation

TABLE 2-1 Single Host Deployment Example Data (Continued)

Item Value Notes

Instant Messaging URL http://wireless.map.beta.com/im

Delegated Administrator http://wireless.map.beta.com/da/DA/Login

URL

Top-level administrator ID amadmin Used for logging into Access Manager and
Delegated Administrator.

Administrative password adminpass For all administrative users except
amldapuser.

amldapuser password nonadminpass

User accounts duncan, kathy, tina, robert, test

User password demo For all accounts.

User creation /opt/SUNWcomm/bin/commadmin See “Creating User Accounts for This
Evaluation” on page 20 for more
information.

Ports Web/AddressBook/UWC: 80 (new UT)

Webmail: 8080 (legacy UT)
Webcal: 3080 (legacy UT)
LDAP: 389
SMTP: 25
User Base DN o=isp
Organization DN o=map.beta.com,o=isp Used for Connector for Microsoft Outlook.

Client Syst

Note - You should be able to use this guide with any system that has the Communications Suite
software installed. However, the names, paths, passwords, and so forth mentioned in this guide
might differ from the data you use.

em Interoperability Requirements for this

Evaluation

Akey benefit of Sun Java Communications Suite is its interoperability with other communications
components and solutions. This evaluation demonstrates interoperability with Gaim and Microsoft
Outlook. Gaim demonstrates the XMPP-based interoperability of Sun’s Instant Messaging solution.
This evaluation assumes you are using Java Web Start 1.4.2. Java Web Start 1.5 also works if certain
certificate signing conditions are met. Enable your browser to allow pop-up windows.
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Client System Interoperability Requirements for this Evaluation

Download the additional software from the following locations.
Gaim http://gaim.sourceforge.net

Java Web Start 1.4.2 http://java.sun.com/j2se/1.4.2/download.html

Simply install the J2SE JRE as Java Web Start is contained within the JRE.

To Configure Gaim for This Evaluation

After you download and install Gaim on your client system, you must configure Gaim with a user
account that connects to the Sun Java System Instant Messaging server.

Start Gaim.
Click the Accountsicon.

Click Add in the Accounts window and type the following information.

Protocol Jabber

Screen Name robert

Server wireless.map.beta.com
Resource Gaim

Password demo

Alias Robert

Click Save button to save the options.

Click Close in the Accounts window.

Use the Account drop-down menu in the main Gaim window to select the account.
Type the password demo for the account and click the Sign on icon.

Accept any subsequent dialog boxes that appear.
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Creating User Accounts for This Evaluation

Creating User Accounts for This Evaluation

This evaluation makes use of a number of user accounts. These user accounts are duncan (Duncan
Hoff), kathy (Kathy Singer), tina (Tina Givens), robert (Robert Smith), and test, with a password
of demo for all user accounts. After you create these accounts, you use them to create some sample
email and calendar data.

v To Create User Accounts for This Evaluation

1  Usethe Delegated Administrator command-line utility commadmin to create user accounts.

/opt/SUNWcomm/bin/commadmin user create -D admin -F first-name -1 userid -L last-name
-n map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E
useridemap.beta.com -H wireless.map.beta.com -k legacy

first-name Represents the user’s first name.
userid Represents the user ID.

last-name Represents the user’s last name.

2 Create the user accounts for the demo scenarios in this guide by following these examples.

/opt/SUNWcomm/bin/commadmin user create -D admin -F Duncan -1 duncan -L Hoff -n
map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E
duncan@map.beta.com -H wireless.map.beta.com -k legacy

/opt/SUNWcomm/bin/commadmin user create -D admin -F Kathy -1 kathy -L Singer -n
map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E
kathy@map.beta.com -H wireless.map.beta.com -k legacy

/opt/SUNWcomm/bin/commadmin user create -D admin -F Tina -1 tina -L Givens -n
map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E
tina@map.beta.com -H wireless.map.beta.com -k legacy

/opt/SUNWcomm/bin/commadmin user create -D admin -F Robert -1 robert -L Smith -n
map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E
robert@map.beta.com -H wireless.map.beta.com -k legacy

/opt/SUNWcomm/bin/commadmin user create -D admin -F Test -1 test -L User

-n map.beta.com -p 80 -w adminpass -W demo -X wireless.map.beta.com -S mail,cal -E
test@map.beta.com -H wireless.map.beta.com -k legacy

20 Sun Java Communications Suite 2005Q4 Evaluation Guide - May 2006



Creating User Accounts for This Evaluation
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To Add Auxiliary Services to Users

After creating users, use the Access Manager console to add auxiliary services to each user.

In a web browser, type the URL for the Access Manager console.

http://hostname/amconsole

For example, http://wireless.map.beta.com/amconsole.

Login as amadmin with a password adminpass.

You see a view of the available organizations. Click the link of your main organization map. beta. com.

In the left pane, select Users from the View drop-down menu.

You should see your primary users Duncan, Kathy, Tina, Robert, and test.
Click the property arrow beside Duncan Hoff's name.

In the right pane, select Services from the View drop-down menu.

Click Add in the right pane to add services.

Select the check box at the top that contains an icon of two check marks.

This check box selects all services.
Click OK at the bottom to verify your selection.
Repeat steps 4 through 8 for usersKathy, Robert, Tina,and Test.

Grant additional access rights to the main user in the next task.

To Grant Additional Access Rights to Users

This procedure gives special access controls to the main user Duncan.
In the left pane of the Access Manager console, click the isp link near the Identity Management tab.
Select Roles from the View drop-down menu in the left pane.

To assign a user to the IM Conference Rooms Administrator role, click the property arrow beside the
IM Conference Rooms Administrator.

In the right pane, select Users from the View drop-down menu.
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Click Add in the right pane.
In the User ID field, type duncan and click Next.

Select the check box next to Duncan’s name and click Finish.

Now Duncan has permission to create conference rooms.

Click the Service Configuration tab.
The left pane displays a list of services.

Click the property arrow beside the Session service.

Scroll to the bottom of the list of attributes and change the following to enable you to complete the
evaluation without experiencing auto timeouts:

Maximum Session Time 960
Maximum Idle time 720
Click Save.

Log out of the Access Manager Console.

Create sample data in the next task.

Creating Sample Data for This Evaluation

22

Prior to executing the evaluation , you need to configure the user accounts for sharing data and
prepare the system for many of the scenarios that you use later in the evaluation. In addition, these
procedures introduce you to some of the basic functionality of the Sun Java Communications Suite.

In this section, you are introduced to basic functionality as you create the following:

Sample address book data

Sample messaging and calendaring data
Sample resources

Sample Instant Messaging data
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v To Create a Sample Address Book with Data for the
Main User

1 Inaweb browser, type the URL for Communications Express.
http://hostname/uwc.

For example, http://wireless.map.beta.com/uwc.

2 Loginasthemain user duncan with the password demo.

You are now logged into Communications Express with the Mail tab selected as the default.
3 Clickthe Calendar tab to view the Calendar.
4 Clickthe Address Book tab to view the Address Book.
5 Toadd contacts, type the contact’s information in the Add Contact section.

a. IntheFirstfield, type Robert.

b. IntheLastfield, type Smith.

¢. Inthe Email field, type robert@map.beta. com.

d. Click the Add Contact button.

6 Repeat step 5 for contacts Kathy Singer and Tina Givens.

An alternate way to create contacts that enables you to enter more information is through the New
Contact icon in the Address Book UL

7 Clickthe New Contacticon.

A New Contact window appears.

a. IntheFirst Name field, type Duncan.

b. IntheLast Name field, type Hoff.

¢. Inthe Primary Email field, type duncan@map . beta. com.
d. Typeany additional information you choose.

e. Click Save to create the contact.

8 ClickLog Out to log off as Duncan from Communications Express.

Chapter2 - Preparing to use the Communications Suite Evaluation 23



Creating Sample Data for This Evaluation

9 Create more sample data in the next task.

v To Create Sample Messaging and Calendaring Data

This procedure configures Messaging Server and Calendar Server so that the main demo user,
Duncan, has email in his inbox and invitations in his calendar. This procedure also introduces you to
the basic mail and calendar functionality provided by Sun Java Communications Suite. In these
steps, you learn how to create invitations and how to modify the permissions on your calendar so
that others can view your appointments. You also create calendar resources.

You should already have the Communications Express login screen displayed in your web browser.
1 Loginasuser tina with the password demo.
2 Todisplay Tina's calendar, click the Calendar tab.

3 Fromthe Current Calendar drop-down menu, select Manage Calendars.

The Manage Calendars window appears that displays information about the Personal Calendar for
Tina Givens.

4 Tochange calendar permissions, click the Edit link in the Properties column.

5 Inthe Edit Calendar window, select the Anyone Can Read My Calendar check box.
6 Click Save to save the calendar.

7 Clickthe Week view at the top of the Calendar Ul.

8 Tocreate an appointment, click the New Eventicon.

The New Event window appears.
9 Fillin the event template.
a. Typeatitle for the event, astart date and time, an end date and time, and a location.
b. Toinvite Duncan, type duncanin the Invitee field.
c. ClickAdd.
10  Click Save to create the event and invite Duncan.

11 Clickthe Log Out link to log off Tina from Communications Express.
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Before You Begin

Login as user kathy with the password demo and repeat steps 2 through 11.

Create the event for a different date and time, but be sure to invite Duncan.
Click the Log Out link to log off Kathy from Communications Express.
Login as user robert with the password demo.

Repeat steps 2 through 6 to make Robert’s calendar readable by others.

Do not create a new invitation.

Create more sample data in the next task.

To Create Sample Resources

You can use Calendar Server to schedule both people and resources, such as conference rooms and
audio/visual equipment. To schedule resources, you must first create the resources.

You must be logged in as root to perform this task.

In a terminal window, type the following.

cd /opt/SUNWics5/cal/sbin
./csresource -m calmaster@map.beta.com -c RoomA create RoomA
./csresource -m calmaster@map.beta.com -c ProjectorA create ProjectorA

These commands create two resources (RoomA and ProjectorA) that will be used in subsequent
exercises.

Log outas root.

Create sample messages in the next task.

To Create Sample Messages

This task guides you through the process of composing email. While logged in as Robert, you
compose a few messages to verify that Messaging Server is functioning properly and also ensure that
Duncan has email in his inbox.

To display Robert’s mail, click the Mail tab at the top of the Communications Express Ul.

To send a test email to Duncan, click the Compose link.

a. IntheTofield, type duncan@map.beta. com.
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b. In the Subject field, type Vacation last Month.

¢. In the main body of the message, type I discovered many herbal remedies during my
vacation last month. as the message content.

d. Click Sendto send the message.

To send a test email to Duncan with urgent priority, compose a second message.

a. IntheTofield, type duncan@map.beta.com.

b. In the Subject field, type Urgent: Please Review.

¢. In the main body of the message, type Duncan, please review this document ASAP.
d. Inthe Priority drop-down menu, change the message priority to Urgent.

e. Toattach adocument, click the Attach icon at the top of the New Message window to attach a
document.

An Attach File window appears.

f. UsetheBrowse button to identify any document, and click Add to add the document to the
attachment list.

g. Click Attach to attach the document to the email.

h. Click Send to send the urgent email to Duncan.

Duncan will receive this urgent email when he logs in later.
Click the Log Out link to log off Robert from Communications Express.

Create more sample data in the next task.

To Create Sample Instant Messaging Data

In this procedure, you start Instant Messenger, and create the buddy lists for each of the four users in
the demo. The Instant Messenger channel will recognize that other users are logged in and will
present the status of online buddies as the main user logs in.

To start Instant Messenger as users duncan, robert, and kathy, you can use a multi-protocol client
such as Gaim as well as Sun’s Instant Messenger client. If you have problems logging into Instant

Sun Java Communications Suite 2005Q4 Evaluation Guide - May 2006



Creating Sample Data for This Evaluation

Before You Begin

10

1

Messaging by using Java Web Start, check for problems with certificate signing. If so, try Java Web
Start minimum 1.4.2. Using Gaim is not essential, however, by using Gaim, you view the
interoperability of the Instant Messaging solution.

See “To Configure Gaim for This Evaluation” on page 19 for instructions on downloading and
installing Gaim, and for configuring a Gaim user account.

Using the Gaim client, log in to Instant Messaging as user robert with the password demo.

Start a web browser and type the following URL for Instant Messenger:
http://hostname/im

For example, http://wireless.map.beta.com/im.

To load the Instant Messaging resources, click Start and log in as kathy with the password demo.

Click any subsequent approval buttons to start the Instant Messaging client.

Once Kathy’s client has been started, click the Start button again and log in as user duncan with the
password demo.

Do not start Instant Messenger for Tina yet.

In Duncan’s main Instant Messaging window, click the Add Contacts icon (represented by a person’s
head).

Type the first name of the contact you want to add (Robert) in the name field then click Find Contact.

Robert’s name appears in the Contacts to Add text area.
Type another name, say Kathy, and click Find Contact to add this name to the Contacts to Add area.

Click OK to add these contacts to Duncan’s buddy list.

Several approval dialog boxes appear.

Tip - One of the features of Sun Java System Instant Messaging is Contact List Authorization. In this
way, No one can see a given user’s presence without the user’s authorization. By default, contact list
authorization is turned on, but users can turn it off to give others the ability to view their presence
without authorization.

Accept all contact list authorization requests.
Repeat steps 5 through 9 to create contact lists for Robert and Kathy.

Log off Duncan only from Instant Messaging.
Keep Robert and Kathy logged in.
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12  Make sure that some users are logged into Instant Messaging and start the Portal Server desktop.

Begin exploring Sun Java Communications Suite, as explained in Chapter 3.
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L R R 4 CHAPTER 3

Communications Suite Walkthrough

This chapter provides a tutorial-type walk through of the key features of the Sun Java
Communications Suite. You experience working with the messaging, calendaring, and address book
components of the Communications Express Ul as well as use Connector for Microsoft Outlook
and Instant Messaging.

This chapter contains the following topics:

® “Communications Suite Through Portal Server” on page 29
= “The Communications Express Demo” on page 30

“The Messaging Demo” on page 32

“The Calendar Demo” on page 35

“The Address Book Demo” on page 42

“The Connector for Microsoft Outlook Demo” on page 43
“The Instant Messaging Demo” on page 44

Communications Suite Through Portal Server

Now that you have created a few user accounts and have added data to these accounts, you can see
the possibilities offered by Sun Java Communications Suite. The main accounts are duncan, kathy,
robert, and tina. For most of the evaluation, you are logged in as duncan.

Sun Java System Portal Server is not a core component of Sun Java Communications Suite but itis a
logical place to view the aggregated services provided by Sun Java Communications Suite. The Portal
Server desktop puts all of the content into a single view separated into channels or portlets. In
addition, Sun Java System Access Manager provides single sign-on and the access layer responsible
for role and policy-based access control, which is evident in the Instant Messaging exercises.

This section uses the Portal Server desktop to view the Communications Suite channels to start the
Communications Express UL
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The Communications Express Demo

v

To Start the Portal Server Desktop and Launch
Communications Express

Starta web browser.

For this demo, use Internet Explorer.

Type the URL of the Portal Server desktop in your browser.
http://hostname/portal/dt

For example, http://wireless.map.beta.com/portal/dt.

When the Portal Server desktop appears, use the Log In portlet to log in as duncan with password
demo.

The desktop reappears with its various channels presenting information about Communications
Suite services to which duncan has access.

An Instant Messaging channel shows the status of online buddies and a Calendar channel shows
outstanding events and tasks. A Mail channel and an Address Book channel are also present.

Launch the Calendar channel by clicking the Launch Calendar link.

The Communications Express Ul appears in a new browser window.

Continue with the Communications Express demo.

The Communications Express Demo

Before You Begin

30

This section describes how to use the Communications Express UI to compose mail, create calendar
events, and use the address book.

To Forward a Message and Schedule a Meeting

The following scenario highlights the integration between mail, calendar, and address book: Duncan,
upon starting Communications Express, views his inbox and sees an urgent email with a document
that he must review. He forwards this message to his team for review and suggests a follow-up
calendar appointment to discuss the document.

Ensure that you are logged in as user duncan as explained in “To Start the Portal Server Desktop and
Launch Communications Express” on page 30.

Click the email message with the subject URGENT: Please Review.

This urgent message must be forwarded to Duncan’s team for review.
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Click the Forward button.

The New Message window appears. Integration with Address Book is provided in the New Message
window.

Click the Toicon (represented by a rolodex) to view Duncan’s personal address book and select
recipients.

The Add From Address Book window appears. Duncan can search members of his Personal Address
Book or the Corporate Directory. This demo uses the Personal Address Book.

Select the To check box for Tina and Kathy to forward to them the mail Duncan received. Then click
Add Recipients.

The names of Tina and Kathy are filled in the To line in the New Message window.

Compose a message and select the priority as Urgent from the Priority drop-down menu.

Also click the Spell Check link at the top of the window to perform an automatic spell check.

Compose the message in plain text or rich text.
Click Send when you are done composing Duncan’s message.

To schedule a follow-up meeting with Duncan’s team, click the Calendar tab in Communications
Express.

The Calendar view appears.

In general, you see the day view. If any group scheduling events exist for the day, a color code is
assigned to the appointment indicating how many invitees have accepted or declined the invitation.

Click the Week view to see appointments for the week.

Click any of the + icons for the following work day to schedule an appointment.

ANew Event window appears.

In the Invitee field, click Add from Address Book to add Tina, Kathy, and Duncan.

Select the check box next to their names and click Add Invitees. You can also type RoomA in the
Invitee field because Calendar Server can be used to schedule resources as well. Be sure to click Add
to add the RoomA resource.

Click Check Availability.
A Check Availability window appears showing the entire free busy for the group.

Select afree time by clicking the + icon above the time that is free.

Click Close to close the Check Availability window.
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Continue filling in the New Event template.

You can modify the event type or category, the location, the frequency, or other attributes. Be sure to
include the Title, in this case, Emergency Meeting.

Click Save to schedule the eventin the calendar.

The New Event window closes, and the event appears on the calendar.

You have used the Communications Express interface to use the address book, send mail, and
schedule a calendar resource.

Continue with the next demo.

The Messaging Demo

32

In this section, you explore more advanced features such as message searching, sharing and
subscribing to folders, and message filtering. In the mail U, there is a Quick Search that enables you
to search for a mail by subject and a more advanced Search that enables you to search by several
criteria.

To Search Messages

While still logged in as user Duncan, click the Mail tab in the Communications Express Ul.

Alist of Duncan’s messages appears.

Click the Searchicon.

A Search pop-up appears. Search Duncan’s Inbox for any email that has the word herbal in its body.
You can search on subject, sender, body; to, or cc.

Select Body from the first drop-down menu and make sure that the next drop-down menu shows
contains.

Type herbalin the blank field and click Search.

The focus changes to the Communications Express UI where the results of the search are displayed.

Click one of the returned search messages and read it.

Note - You can search any of your folders, not just your inbox. You can also specify up to three search
criteria.

Return to the Search pop-up and click Close.

Continue with the next task.
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To Share Folders

While still logged in as user Duncan, click the Manage Folders icon.

The Folders view appears.

Click the New icon to create a new folder.

A dialog box appears, prompting for a folder name.

Type the name of the new folder Presos, and click OK.

The new folder appears in the Folders list.
To share this folder, select the radio button beside the new folder.

In the Folder Actions drop-down menu, select Share Folder.

The Share Folder window appears.

From the Permissions drop-down menu, choose Read and Write to give all users read and write
permission.

Note - You can give a folder read-only permission, or read, write, and manage permission. Also, you
can share your folder with specific individuals by typing their user ID in the permissions list.

Click OK to share the folder.

The Share Folder window closes, and the Preso folder in the Folders list now has a check mark
indicating that it is shared.

Start a separate web browser and type the URL of Communications Express.

http://hostname.map.beta.com/uwc

For example, http://wireless.map.beta.com/uwc.

The browser should be completely separate. For example, if you used Internet Explorer to perform
the previous steps, launch Firefox or Mozilla. You can also launch a browser from a separate client
system.

Login as user robert and a password of demo.

Follow steps 1 through 7 to create a folder called Test Messages.

Click Log Out to log off Robert from Communications Express.

Continue with the next task.
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To Subscribe to a Shared Folder

In Duncan’s Communications Express session, click the Subscribe icon at the top of the Folders
window.

A Subscribe to Shared Folders window appears.

In the Select from Folders drop-down menu, choose All Shared Folders and click Go.
Alist of shared folders appears.

Select the check box next to the Test Messages folder and click Subscribe.

You have just subscribed to the Test Messages folder and can now read mail in the folder or move
mail into the folder, provided that you have the proper permissions.

Continue with the next task.

To Use Mail Options and Filters

In the Communications Express Ul, click the Options tab to access the Mail Filters category.

Mail options are selected by default. You use the links to specify the category of Mail options that you
can modify. In addition to Mail Filters, you can also specify Settings, Layout, Vacation Message and
more.

To add a mail filter, click Mail Filters.
The Options-Mail Filters Ul is displayed.

To define a mail filter, click New.

Type Spamfree as the filter name.

Select the Match All of the Following Conditions radio button.

Select Subject from the left-most drop-down menu and contains from the middle drop-down menu.
In the text entry box, type free.

Click Add to add a new condition.

Select Sender from the left-most drop-down menu and does not contain from the middle drop-down
menu.

In the text entry box, type beta. com.
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11 Select the Move Message to the Folder check box and select Trash from the drop-down menu.

12  Click Save to save the filter.

Now any messages that contain the word f ree that are not from your domain are automatically
discarded.

13  Continue with the next section.

The Calendar Demo

In this section, you see the benefits of a flexible calendaring system by creating new calendars,
subscribing to calendars, grouping calendars, viewing calendars, and searching for calendars. You
also use Communications Express to create tasks. Finally, you export and import a calendar, and you
personalize your calendar by modifying calendar options.

v To View Calendars: User Interface

1 Whilestilllogged in as Duncan, in the Communications Express Ul, click the Calendar tab.

When you first select the Calendar tab, your default calendar is displayed in the default view. You can
later select a calendar from the Current Calendar drop-down list to view and create events and tasks.
The Current Calendar drop-down list may include personal calendars, subscribed calendars,
calendar groups, and temporary virtual calendars. For the selected calendar, you can see events and
tasks in traditional or object oriented views that include the Day View, Week View, Month View, Year
view, Tasks View, Events View, and Invitations View.

In the Day View, the main calendar view displays a color-coded appointment for group events. The
green box indicates the number of invitees who have confirmed the appointment, the yellow box
indicates the number who have tentatively accepted, and the red box indicates the number who have
declined the invitation. The grey box indicates the number who have not yet responded to the
invitation.

At the bottom of the Calendar tab, Duncan’s calendar is:
http://wireless.map.beta.com:80/uwc/?calid=duncan. Every calendar has its own unique URL
that you can send to other users. If you give users permission to view your calendar, they can view it
by using this URL.

Above this URL is the quick-event feature that enables you to create an event with a minimal set of
attributes such as event title, date, and time. This feature is ideal for creating non-recurring events
with no attendees.

2 Click the Week view, located as a sub-tab of the Calendar tab.

Examine the events in the calendar for the week.
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36

To view other calendars, select a calendar from the Current Calendar drop-down menu.

Since you haven’t yet subscribed to or created additional calendars, you do not see many calendars in
this list. However, after you subscribe to or create new calendars, you are able to select and view
them.

You can view the calendars of other individuals provided that you have their permission. For
example, if you had previously subscribed to Kathy’s or Robert’s calendar, select kathy or robert to
view their calendars.

Continue with the next task.

To Create and Subscribe to Calendars

Creating and subscribing to calendars is similar to mail folder operations. In this task, you create a
publicly viewable calendar called Demos and a private calendar called Family.

Select Manage Calendars from the Current Calendar drop-down menu.

The Manage Calendars view appears.

Click the New Calendar button to create a new calendar.

The New Calendar window appears.

Type the calendar information.

a. Typea Calendar Name with no embedded spaces (for example, Demos).

b. Type a Display Name, which can include spaces (for example, Demos Calendar).

Select the Anyone Can Read My Calendar check box so that this calendar is viewable by everyone.

You might need to scroll the window to see this option.

You can also share this calendar with specific users by typing their user ID and selecting the
individual permissions check boxes.

Specify a delegated owner for this calendar by typing kathy in the Owner Name text entry area and
click Add.

You can also specify a time zone for this calendar or use the default time zone.
Click Save to create the calendar.

Click New Calendar to create another calendar.

The New Calendar window appears.
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Type the calendar information.
a. TypeaCalendar Name with no embedded spaces, for example, Family.
b. Type a Display Name, which can include spaces, for example, Family Calendar.

Click Save to create the calendar.

This calendar is not publicly readable because read permission is disabled by default.

Click Subscribe to subscribe to an existing calendar.

The Subscribe to Calendar window appears.

Type tinain the Search field and click Search.

Search results are returned to the window.

Select the check box next to the calendar you want to subscribe to and click Subscribe to Calendar(s).

The new calendar is displayed in the Manage Calendars view.

Continue with the next task.

To Create Calendar Groups

Calendar groups are composite calendars formed by individual calendars superimposed upon each
other to create a single virtual calendar.

While logged in as Duncan, click New Calendar Group.
Type the Group Name MyCals.

Select duncan and duncan:Family from the Quick Add Personal or Subscribed Calendar drop-down
menu to create a calendar group composed of these two calendars.

Click Save.

Click the New Calendar Group button again to create a group composed of personal and subscribed
calendars.

Type the Group Name AllCals.

Select duncan, duncan:Family, and tina from the Quick Add Personal or Subscribed Calendar
drop-down menu to create a calendar group composed of these calendars.

Click Save.
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9 Choose Duncan’s Family calendar (duncan:Family) from the Current Calendar drop-down menu.
10  Click Week to see the Week view.

11 Select MyCals from the Current Calendar drop-down menu to show a composite of personal and
family calendars.

Communications Express enables you to layer your calendars on top of each other to present a single
virtual calendar.

12 Select AllCals from the Current Calendar drop-down menu to show all calendars that you have
subscribed to layered on top of your own calendars.

Click Month to see all events for the month.

13  Select duncan (Duncan Hoff) from the Current Calendar drop-down menu to return to duncan’s
calendar.

14 Continue with the next task.

v To Use Other Calendar Views

1 Click the Events link to get an Events view.

2 Select Events for Week from the Show drop-down menu.

You can list the events by day, week, month, and by type. You can also filter these events. For
example, you might only want to show Accepted events or Declined events.

3 Clickthe Invitations link to get an Invitations view.

4  SelectInvitations for Week from the Show drop-down menu.

You can accept a meeting from Kathy, Tina, or Robert directly from this view.
5 Clickthe Eventslink.
6 Choose AllCals from the Current Calendar drop-down menu.

7 Continue with the next task.

v To Search Calendars

1 TypeEmergency in the Search for Events field and click Search.
All events with the keyword Emergency appear.
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You can also search for Calendars in addition to events within calendars.

Click the Search for Calendar icon at the top of the Calendar Ul.

The Search for Calendar window appears.

Type Family in the Search for Calendar text entry box and click Search.

All calendars with the word Family are displayed.
Click the Cancel button in the Search for Calendar window to dismiss the window.

Continue with the next task.

To Create New Calendar Tasks

A task is a single item that you need to do. Tasks are similar to events and are created in almost the
same way. The difference between tasks and events is that tasks appear in a tasks bar to the left of the
calendar and events appear within the Calendar itself. Tasks also have a completion status whereas
events do not. If team members collaborate with one another, the task feature lets members notify
one another of a task’s status or when a task is completed. In this demo, you create a public task that
others can view when they subscribe to your calendar.

Click the Week view tab.

Click the New Task icon.
The New Task window appears.

Fillin the task template.

a. TypeProgress Report in the Title field.

b. Verify that the Start Date and Due Date are today’s date.

¢. Setthe Due Time for 5:00 PM or some other time in the future.
d. Select25% from the Status drop-down menu.

e. Select Public Task from the Privacy drop-down menu.

f. Typealocation.

Click the Save button.
The newly created task appears in the task bar to the left of the Calendar.
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Continue with the next task.

To Import and Export Calendars

Occasionally, you export a calendar to a file to import into another calendar. For example, you have
subscribed to a read-only calendar but you want your own copy that you can modify. Or, you want to
share a calendar with others who do not have access to your calendar server. You might also want to
export your calendar to make a backup copy.

Sun Java System Calendar Server supports the iCalendar standard calendar schema definition (RFC
2445), and consequently can import and export calendar data in this format. Calendar Server can
also import and export calendar data in an XML format.

In this demo, will export your default calendar to a file and then import that file into an empty
calendar.

Click the Import/Export icon.

The Import and Export Calendar window appears. You will first perform a calendar export.

In the Calendars to Export drop-down menu, select duncan (Duncan Hoff).

This is Duncan’s default calendar.

In the File Format drop-down menu, select iCal.
An XML format is also available.

Select All for the Date Range.

Click Export to export the calendar data.

You see one or more dialog boxes requiring you to verify that you want to save a file. Additionally,
you are prompted for a location to save the file. Note the location where the export. ics file is saved.

Approve all dialog windows to save the calendar file and dismiss any pop-up windows that remain
after the file has been saved.

The Import and Export Calendar window should stay visible. Do not dismiss this window because
you use it to import the recently saved file.

In the Import to Calendar drop-down menu, select the recently created empty calendar called Demos.

If you do not have an empty calendar, create one. See “To Create and Subscribe to Calendars”
on page 36.

Click Browse to select the recently exported file that is inserted into the Import from File field.

When you click Browse, a window appears prompting you to select the file that you exported earlier.
By default, the file name is export. When you have located and selected the file, click Open to insert
the file name into the Import from File field.
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In the File Format menu, selectiCal.

An XML format is also available.
Select All for the Date Range.

Click Import to import the calendar data into the Demos Calendar.

The following message appears at the top of the Import and Export Calendar window: Successfully
Imported the data to the selected calendar

Click Close to close the Import and Export Calendar window.

From the Current Calendar menu, select the duncan:Demos calendar to view the results.

Notice that this calendar has the same events that are in Duncan’s default calendar. Also notice that it
is not possible to modify these events because the calendar id (calid) of the Organizer does not match
the calid of the Demos calendar. To modify events, edit the export.ics file and change the value of
the ORGANIZER’s calid from duncan to duncan:Demos.

Continue with the next task.

To Set Calendar Personalization Options

In this demo, you familiarize yourself with some of the calendar personalization options.

In the Communications Express Ul, click the Options tab.

The Calendar Options user interface appears. The option interface allows you to personalize the
appearance of the calendar user interface. You can change the default calendar view, the daily time
scale, how you want the work week to appear, and more. The default calendar time zone is a global
property that other applications can use.

Click the Global tab just beneath the Mail tab to access the global time zone property.

You see the default time zone for this calendar. Change the time zone by selecting it from the list that
appears.

Select your appropriate time zone then click the Save button.

Continue with the next demo.
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The Address Book is the core component of Communications Express that ties together mail and
calendar functionality. Not only can the Address Book be used to create a rich amount of information
for each contact, but it can also be used to launch a variety of actions for each contact.

To Experience Address Book

In this exercise, you create a contact, and you perform an action using that contact. You also
familiarize yourself with the methods to create contacts.

Click the Address Book tab at the top of the Communications Express Ul.

Select the check box next to Kathy’s name and select View Calendar from the Select action
drop-down menu.

Kathy’s calendar is displayed.

Tip - You can also send email by selecting Send email.

Click the Address Book tab and click the double checked box above all the check boxes.

All check boxes are selected.

Select View Calendar again.

All selected calendars can be viewed at the same time.

(Optional) Create new contacts.

Click the New Contact icon, or use the quick add feature, to add a contact. You can also use the
Address Book user interface to search, group, import, export, and print.

For now, you have now finished the Communications Express evaluation.

Do not close your browser; stay logged on as the current user.

If you log off, you end the current Access Manager session, which prevents you from launching new
applications from the Portal Server desktop until you re-authenticate.

Minimize the Communications Express browser window.

Continue with the next demo.
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The Connector for Microsoft Outlook Demo

Clients are generally classified as either thick clients (also known as a fat client or rich client) or thin
clients (also known as web clients). A thick client performs the bulk of any data processing
operations itself and relies on the server it is associated with primarily for data storage. A thin client
relies on a web server for data processing operations. So far, you have seen how to use the
Communications Express thin client for evaluating Sun Java Communications Suite. Now you will
learn how to use a thick client such as Evolution or Microsoft Outlook. Thick clients provide certain
features that the Communications Express web client does not, such as drag and drop capability and
disconnected support. The Sun Java Communications Suite supports the use of Microsoft Outlook
on the front end for email, calendar, and address book.

v To Experience Connector for Outlook

1 Install and configure Sun Java System Connector for Microsoft Outlook on your desktop system.

For this demo, use the ports and organization DN specified in “Using the Single Host Deployment
Example” on page 17. You then create a profile for Duncan Hoff.

See the Connector for Outlook documentation for instructions on how to install and configure
Connector for Outlook: http://docs.sun.com/app/docs/coll/1312.1

2 Execute Duncan’s profile then start Microsoft Outlook.

You do this only one time. Upon starting Microsoft Outlook, you see the Outlook Today view, which
provides a summary of your appointments, tasks, and messages.

3  Clickthe Calendaricon in the Outlook Shortcuts pane.

Your weekly schedule is displayed.

4 Dragand drop one of the meetings to a new time, for example, drag the Emergency Meeting you
created earlier.

You might have to advance to the following day to see this meeting. If this event has invitees, approve
attendees being notified of the event change.

5 Maximize the Communications Express window and refresh the Calendar view.
The event time has changed for the event you dragged.

6 Clickthelnboxin the Outlook Shortcuts pane.

You should see your Inbox.

7 Clickon amessage in your Inbox to view it.

For example, click the Urgent message from Robert Smith.

The mail displays.
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In Microsoft Outlook, click the New icon to compose a new message.

A new window allows you to compose a message.

Click the To: or CC: buttons to address your email.

You can show names from your Contacts, but you can also select the Global Address List.

Select Global Address List from the menu.

Connector for Microsoft Outlook requires access control changes to the directory server to support
the Global Address List. See Chapter 6, “Sun Java System Connector for Microsoft Outlook 7 2005Q4
Release Notes,” in Sun Java System Communications Services 2005Q4 Release Notes for more
information. If the directory server has been configured to support the Global Address List, you are
able to view all the users in the Directory. You do not actually send email to anyone is this list.

Click Cancel to close the Select Names window.

Close the Compose window and reject any requests to save changes.

Click Contacts in the Outlook Shortcuts pane.

You should see your address book contacts.

In Microsoft Outlook, create a new contact.

a. Typeafullname and an email address.

b. Savethe contact.

Click the Address Book tab in Communications Express to see the new contact.
Experiment with other Connector for Outlook features.

Continue with the next demo.

The Instant Messaging Demo

44

Now return to the Portal Server desktop demo (“Communications Suite Through Portal Server”
on page 29) where Instant Messaging was presented as a channel within the Portal Server desktop.
The channel displayed all of Duncan’s online buddies.

In this section, you start the Sun Java System Instant Messaging client, Instant Messenger, and use it
on its own. Like Sun Java System Messaging Server and Sun Java System Calendar Server, Sun Java
System Instant Messaging is also standards based. Java System Instant Messaging uses the XMPP
protocol, which is an IETF standard also referred to as the Jabber standards. Because the Instant
Messaging server and client communicate using XMPP, they can interoperate with any other
XMPP-compliant server or client.
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Before You Begin

To Chat

Robert is already logged in as a Gaim user and Kathy is logged in as a Sun Java System Instant
Messaging user. For more information about Gaim, see “To Create Sample Instant Messaging Data”
on page 26. You access the Portal Server desktop as Duncan.

From the Portal Server desktop channel, start Instant Messaging by clicking the Instant Messenger
linkin the channel.

The Instant Messaging window appears with a list of Duncan’s contacts and contact groups. If there
are no contact groups, you can create one later.

From Duncan’s Instant Messaging window, double-click the presence icon for Robert to initiate a
chat with this online buddy.

Start chatting with Robert.

Robert’s name appears in a tab in the chat window. You can change the text font, size, color and more
while chatting. Instant Messaging also supports emoticons and file attachments.

From Duncan'’s buddy list, start a chat with Kathy by double-clicking on Kathy’s presence icon.

Duncan’s chat window now shows two tabs: one for Robert and one for Kathy. You can have multiple
simultaneous chat sessions from the same chat window through this tabbed interface.

Continue with the next task.

To Manage Individual and Multiple Buddy Chat
Sessions

Use this procedure to end one chat session while keeping other chat sessions active.
In Duncan’s chat window, click the tab for Robert.
Click the File link and select Leave.

Approve any verifications.

This does not affect your chat session with Kathy.
Chat more with Kathy.

Continue with the next task.
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To Invite Others to Chat

You can invite others to join your current chat window.
In Duncan’s chat window, click Invite Users to Chat (icon of a person’s head).

Invite Robert to rejoin the chat then click OK.

To invite Robert, you can either select his name from the Contacts List and click the Add button; or,
you can enter his name or User ID in the appropriate field.

Type aninvitation such as Welcome and click OK.

As Robert, click Accept to accept the chat invitation.

Robert is now part of the chat room. This is a dynamic conference room which is different from the
persistent conference rooms you will explore later.

Close Robert’s chat window and quit Gaim.

Close all other chat windows from Duncan and Kathy.
Do not quit the Instant Messaging applications for Duncan and Kathy.

Continue with the next task.

To Create Alerts and Polls

Alerts are pop-up notifications that can be sent to others. Polls are instant surveys that can be sent to
others.

From Duncan’s main Instant Messaging window, select Kathy and choose Alert from the Tools
drop-down menu.

The Send Alert window appears.

Type a subject and compose your alert message.

You can vary the text font, color, place an image, and more.

Select the Show Delivery Status check box and click Send.
The alert appears.

Close all alert windows.

From Duncan’s main Instant Messenger window, select Kathy again.
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Choose Poll from the Tools drop-down menu.

The Poll Users window appears.

Type a poll question.

To change the available answers, highlight the existing answers and remove them. Click Add Answer
to add your own answers.

When your poll question is complete, click Send.

The poll question is sent. As the poll sender, Instant Messaging informs you of the recipients’
answers to the poll.

Continue with the next task.

To Create Conference Rooms

No conference rooms exist for you to subscribe to. However, at the beginning of this evaluation, you
used Access Manager to grant Duncan permission to create conference rooms, so you now exercise
this functionality to create a few conference rooms.

Note - Users Tina and Kathy do not have permission to create conference rooms. You can modify
their permissions by using Access Manager.

In Duncan’s main Instant Messenger window, click the Conferences tab. In Kathy’s main Instant
Messenger window, click the Conferences tab.

In Duncan’s Instant Messenger client, choose Manage Conferences from the File drop-down menu.

The Manage Conferences pop-up window appears.

Click New Conference to create a conference room.

You are asked for a conference room ID and name. For simplicity, choose the same name for both the
ID and the name, for example, ID: Stocks, name: Stocks).

Change the Default Access to WRITE then click OK.

The Manage Conferences pop-up displays the new conference room.
Click the New Conference button a second time to create a moderated conference room.

When prompted for ID and name, type moderated, leave the Default Access at READ and click OK.

The Manage Conferences pop-up window displays the new conference room.

As Kathy, click Add Conferences to add a conference room to the list of subscribed rooms.
The Add Conferences pop-up window appears.
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Click Browse Conferences to get a list of all available conference rooms.

Select any conference other than the moderated room, for example, select Stocks, and click OK.

The selected room appears in the Add Conferences window.
a. Click OKto add the conference in the Conferences tab.

b. Make sure that both Duncan and Kathy have the same conference in their main Instant
Messenger window.

As Duncan, double-click the name of the conference to join it.

As Kathy, double-click the name of the same conference.

Now both members can chat in this conference room.

Continue with the next task.

To Moderate Conference Rooms

Because Duncan created the moderated room, he is the moderator by default. He can add additional
moderators by giving them Manage access.

Close all chat windows for both Duncan and Kathy.
As Duncan, double-click the moderated conference room.

In Kathy's Instant Messenger window, double-click the moderated conference room.

Notice that Kathy’s chat window behaves differently than Duncan’s window. Kathy has only read
permission, but Duncan has read, write, and moderate permission.

In Duncan'’s chat window, choose Moderate from the File menu.

Both Kathy’s and Duncan’s windows change. Resize the corner to change the vertical size of
Duncan’s window to see all of the options.

As user Kathy, type in a chat message and send it.

As user Duncan (the moderator), accept the message.
To accept the message, highlight it and click Accept.

Upon accepting it, the message appears in the main chat portion of the window for all participants to
see.

Continue with the next task.
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To Define Access and Privacy Filters

Users can define their own privacy filters that can be used to block Instant Messaging from certain
individuals or prevent users from seeing another user’s presence status.

As Duncan, choose Settings from the Tools menu.

Select the Privacy tab.
A short list of Privacy Profiles have already been defined.

Click New Profile to add a new privacy profile.
The New Profile pop-up window appears.

a. Inthe Namefield, type PriorityIMand check the Only Users in My Contacts radio button.

Checking the radio button limits the presence updates to only those users in Duncan’s contact
list.

b. UnderBlock Instant Messages From, check the Only These Users radio button and click Add to
define alist of users whose instant messaging traffic you want to block.

The Block Users pop-up window appears.
¢. Inthe Namefield, type Test and click Find Recipient.

d. Selectthe Test user and click OK to add this user to the blocked list.
The Test user appears in the Only These Users list in the New Profile window.

Click OK to create the PrioritylM privacy profile.

This new profile appears in the list of available privacy profiles. You can select any profile to activate
it.

Click Close to close the Settings window.

You have now completed the basic evaluation demos. You can continue with a look at more advanced
Communications Suite features described in Chapter 4
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L R R 4 CHAPTER 4

Communications Suite Advanced Features

This chapter describes some of the advanced features of Communications Suite.

This chapter contains the following sections:

“Using Advanced Instant Messaging Features” on page 51
“Using the HTTP Proxy Gateway” on page 55

“Delegated Administration Demo” on page 56

“Starting and Stopping Services” on page 59

Using Advanced Instant Messaging Features

This section describes how to use Access Manager to provision users and how to configure archiving
for Instant Messaging. Access Manager enables you to create roles and policies and apply those to
users to define their access rights. Previously, this guide described how easy it is to assign a user to a
given role. This section enables you to examine policy and role creation to define a new Instant
Messaging policy.

APl Level Filtering

In “The Instant Messaging Demo” on page 44, you learned that access and privacy filters can be used
by end users to block Instant Messaging traffic or presence updates from certain individuals.
Additional flexibility can be obtained by deploying filters that perform text conversion or block
certain payloads that contain viruses. For example, an administrator can create a filter that blocks or
converts obscene words in an instant messaging conversation. Other uses include text translation,
rich text to plain text conversion, or domain level blocking. Sun Java System Instant Messaging
provides a Message Conversion API that developers can use to create more complex filters that can
be applied to the Instant Messaging Server. Learn more about API level filtering from the Instant
Messaging product documentation (http://docs.sun.com/app/docs/coll/1309.1).
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To Provision Users with Access Manager

In this task, you perform feature-level access control, a powerful tool that enables or disables client
functionality. You create a new instant messaging role and corresponding policy that limits the
instant messaging functionality to the basic features. Users assigned to this new role are not able to
join conference rooms, send polls, or perform any of the other advanced instant messaging tasks.

Access Manager uses the Instant Messaging Service and the Presence Service to manage the Instant
Messaging policy. The Instant Messaging Service contains the policy rules for communicating with
others, as well as the ability to chat, exchange files, join conferences, send alerts, and more. The
Presence Service contains the policy rules for determining the ability of users to share their presence
with others, as well as to access, manage, or publish one’s presence.

Use a completely new web browser to start Access Manager.

For example, http://wireless.map.beta.com/amconsole.

If you are using Internet Explorer for the Portal Server desktop and Communications Express, start
Motzilla or Firefox.

Log in as user amadmin with the password adminpass.

In the top level organization (o=1isp), choose Roles from the View drop-down menu in the left pane
of the Access Manager console.

Click New to create a newrole.
a. Select Static Role, type IM Limited User in the Name field, and click Next.

b. Define the following:

®  Description: Limited access role
= Type of Role: Service
®  Access Permissions: Organization Administrator

¢. ClickFinish to create therole.

Now that you have created this new role, create policies that apply to this role.

In the top level organization (o=isp), choose Policies from the View drop-down menu in the left pane
of the Access Manager console.

Click New to create a new policy.
a. Select Normal, and type Limited access instant messaging in the Name field.

b. Click OK.
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¢. In the Description field, type Policy for Limited access instant messaging users and click
Save.

Choose Rules from the View drop-down menu in the right pane of the Access Manager Console.
Click the New button to define rules for this policy.

a. SelectInstant Messaging Service for the Rule Type and click Next.

b. Type IMLimitedRule forthe Rule Name.

¢. Type IMResource forthe Resource Name.

d. Selectall Action check boxes.

e. Click the Deny radio button for the following Actions:

Ability to Exchange Files

Ability to Join Conference Rooms
Ability to Manage Conference Rooms
Ability to Manage News Channels
Ability to Moderate Conference Rooms
Ability to Read News

Ability to Send Alerts

Ability to Send Polls

f. Click Finish.

g. ClickSave.

You have successfully created an Instant Messaging Service rule for this policy.
Click New to define another rule for this policy.
a. Select Presence Service for the Rule Type and click Next.
b. TypePresenceLimitedRule forthe Rule Name.
¢. TypePresenceResource forthe Resource Name.

d. Selectall Action check boxes, but do not click any Deny radio buttons.

All Actions are allowed.

e. Click Finish.

Chapter4 - Communications Suite Advanced Features 53



Using Advanced Instant Messaging Features

54

10

n

12

13

14

f. Click Save.

You have successfully created a Presence Service rule for this policy.
Choose Subjects from the View drop-down menu in the right pane of the Access Manager console.
Click New to define the mapping between policies and roles.
a. Ensurethatthe Subject Type is Access Manager Roles and click Next.

b. Type IMLimited User in the Name field then click Search to search through the list of available
Access Manager Roles.

c. Findtheroleisp >im limited user, highlight this role, and click Add.
d. Click Finish.

e. ClickSave.

The new roles and policies have been created. Next you assign Tina to this new Role and note the
effect on her Instant Messaging client.

Choose Roles from the View drop-down menu in the left pane of the Access Manager console.

Click on the properties arrow to the right of the IM Limited User role.

The IM Limited User pane appears.

In theright pane, choose Users from the View drop-down menu.
a. ClickAdd ontheright pane.

b. TypeTinainthe User ID field and click Next.

c. Selectthe check box nextto Tina's name and click the Finish button.

You have assigned Tina the Instant Messaging Limited User Role, so she has limited access to
Instant Messaging.

Duncan initially has kathy and robert in his Instant Messaging buddy list. The user tina has not yet
been added. You can click the Start button from the same Instant Messenger window you used to
start kathy. If you start Tina’s Instant Messenger, notice that her window has very limited Instant
Messaging functionality. This type of provisioning is feature-level provisioning that involves defining
roles and policies for these roles. Changing the policy has the effect of removing or adding
functionality to the client itself. You can experiment changing the policy and restarting Tina’s client
to observe the effect. You can also apply the appropriate role to others and see its effect as you start
Instant Messaging as those users.
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v ToArchive Chat Sessions

The Sun Java Communications Suite provides the following two ways to archive chat sessions:

= Archive provider API. Using this AP, developers can extend the archive capability.

= Portal Server search database or Message Store. Without changing any capabilities, you can
archive chat sessions in Portal Server’s search database or in Messaging Server’s Message Store.

By default, the single host deployment example, on which this evaluation guide is based, uses the
Message Store to archive chat sessions. By viewing Duncan’s inbox, you can see that he has several
messages that contain the chat conversations he had with Kathy and others.

To change the Message Store to the Portal Server search database to archive chat sessions, do the
following:

1 Editthe /etc/opt/SUNWiim/default/config/iim. conf file and set the following parameter:

iim_server.msg_archive.provider = "com.iplanet.im.server.IMPSArchive"

2 Restart the Instant Messaging server.
/opt/SUNWiim/sbin/imadmin refresh

3 Performa poll, or a chat, to generate some Instant Messaging data. For performing poll or chat, see
“The Instant Messaging Demo” on page 44.

4  Click the Search tab from within Duncan'’s Portal Server desktop.

5 IntheFind field, type a key word such as pol1 or a word from the chat, and click Search.

The results of the search are displayed. Note that the poll results look like actual final poll results, not
extraneous data points. Also, the entire conversation is returned, not just the sentence containing the
keyword.

Using the HTTP Proxy Gateway

Sun Java System Instant Messaging has an HTTP proxy gateway to connect simple HTTP clients to
the Instant Messaging server. Uses for this include phone clients, simple web-based clients, or other
clients. You can install web-based clients such as jwchat into a web container and use them in
conjunction with your host.
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In addition to command-line tools and Access Manager, Communications Suite has a graphical user
interface called Delegated Administrator, that you can use to provision users, domains, and service
packages.

This section walks you through a scenario that uses Delegated Administrator as if you were a service
provider hosting email for several small companies. As this service provider, you have just signed an
agreement with a new company. You now need to provision the new domain and add the required
mail service for that domain. As the administrator for the service provider, you must also create a
domain administrator who has access to that specific domain only.

To Create a Domain

In this task, you create a new domain for hosting email and you assign different levels of service to
this domain.

Type the following URL of Delegated Administrator in your web browser.
http://hostname/da/DA/Login

For example, http://wireless.map.beta.com/da/DA/Login.

Log in as user amadmin with password adminpass.

The main Delegated Administrator view appears. You are logged in to the root organization and the
default domain appears in the organization list.

Click New Organization.

The New Organization pop-up window appears.
For the Organization name, type demoone. com, and for Domain Status, select Active and click Next.

Skip the Contact Information screen and click Next.

The Account Information screen appears.

Type demoone. com in the Domain field and click Next.

The Select Service Packages screen appears.

Because you are interested in only enabling hosted mail, choose Service Packages that only contain
mail.

Several packages are available, depending on the desired mail quota. Select the bronze, gold, and
platinum check boxes and click Next.

The Mail Service Details screen appears where you allow the administrator to define disk and
attachment quotas for the domain.
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For the Preferred Mail Host, type your host name, for example, wireless.map.beta. comand click
Next.

The Quantity of Service Packages screen appears.

(Optional) If calendar service packs were chosen, establish calendar session timeouts and other
attributes through Calendar Service Details.

Calendar Server has not been configured for hosted domains, so leave all the fields blank and click
Next.

Define the number of Service Packages you would like to assign to this domain.

Because this is a small company of less than 50 people, assign 30 service packages for each type of
service.

a. Changethe number from 1 to 30 for gold, platinum, and bronze service packages and click Next.

The Summary screen appears. The Organization Administrator is automatically created and a
password is generated.

b. Write down the Organization Administrator’s user ID and password for later.

Click Finish.

You have created your first domain.

Click the Log Out link to exit Delegated Administrator.

To Create Users

You have just learned to create domains. In this demo, you will log in as the organization
administrator and create users.

At the Delegated Administrator Login screen, log in as the domain-level administrator.

Use the ID admin_demoone. com. Use the password from the section“To Create a Domain” on page
56.

To Create users for this company, click the New button.
The New User pop-up window appears.

a. Type thefollowing:

®  First Name: Larry
= Last Name: Brown
= Display Name: Larry Brown

b. Click Next.
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¢. Skip the Contact Information screen and click Next.

The Select Service Package screen appears.
d. Selectone of the three packages, for example, bronze. Click Next.

e. Typethe mail service details.

Instead of accepting the default Email Address, change the email address to
lbrown@demoone. com and click Next.

f. (Optional) If you chose a service pack that included calendar service when you originally created
your domain, you will see a Calendar Service Details screen.

If you left all the calendar fields blank when you created the domain, you can leave all the fields
blank in this screen also and click Next.

g. Change the Login ID from Larry_Brown to lbrown. Type the password demo and click Next.
h. Verify the User Information then click Finish to create the user.

Look in the Delegated Administrator user interface to see that the new user has been added to the
demoone. comdomain.

Click the Log Out link to exit Delegated Administrator.

Continue with the next task to verify that the user ID can log in.

ToLogin as aNewly Created User

Type the following URL of Communications Express in your web browser. For example,

http://wireless.map.beta.com/uwc
For this example, the User Name is lbrown@demoone. com and the password is demo.
You are now logged into Communications Express as Larry Brown.

Send test messages to yourself or to other users, such as duncan, kathy, tina,and robertin the
map .beta.comdomain.

Note - Although a Calendar tab exists in Communications Express, the tab is not functional because
you did not enable hosted domains for Calendar Server during the initial installation. You can add or
remove this Calendar tab at a later date if you deploy calendar hosted domains.
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Before You Begin

This section describes the commands needed to start and stop all the Communications Suite

services.

To Start and Stop Services

You should stop services before attempting to start them.

To stop services:

Instant Messaging
Access Manager

Web Server

Calendar Server
Messaging Server
Administration Server

Directory Server

To start all services:

Administration Server
Directory Server
Messaging Server
Calendar Server

Web Server

Access Manager

Instant Messaging

/opt/SUNWiim/sbin/imadmin stop
/etc/init.d/amserver stop
/opt/SUNWwbsvr/https-wireless.map.beta.com/stop
/opt/SUNWics5/cal/sbin/stop-cal
/opt/SUNWmsgsr/sbin/stop-msg
/opt/DSServers/stop-admin

/opt/DSServers/sladp-wireless/stop-slapd

/opt/DSServers/start-admin
/opt/DSServers/slapd-wireless/start-slapd
/opt/SUNWmsgsr/sbin/start-msg
/opt/SUNWics5/cal/sbin/start-cal
/opt/SUNWwbsvr/https-wireless.map.beta.com/start
/etc/init.d/amserver start

/opt/SUNWiim/sbin/imadmin start
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L R R 4 CHAPTER 5

Getting More Information About
Communications Suite

Use the following to obtain more information about Sun Java Communications Suite, or get
assistance from the Sun Java Communications Suite staff.

For More Information

Use the following links to learn more about Sun Java Communications Suite:

®  http://www.sun.com/software/javaenterprisesystem/communications suite/index.xml
®  http://docs.sun.com/app/docs/prod/comm.@5q4#hic

Contacting Sun

For assistance with Sun Java Communications Suite, use the following Sun Forums:

Sun Java System Messaging Server Forum http://swforum.sun.com/
jive/forum. jspa?forumID=15

Sun Java System Calendar Server Forum http://swforum.sun.com/
jive/forum.jspa?forumID=3

Sun Java System Instant Messaging Forum http://swforum.sun.com/
jive/forum.jspa?forumID=113
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